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1. Manage Applications & Shortlisting
This section relates to process REC 6 Manage Applications and
Shortlisting, (and should be read in conjunction with), the recruitment
process outlined on the Personnel Services website at
http://www.admin.ox.ac.uk/personnel/recruit/recruitproc.

1.1 Review and Submit Web Applicants
This will allow you to import all web applications.
Personnel > Recruitment > Maintenance > Submit Web Applicants
1. The Submit Web Applicants form will open. Enter your search
criteria and click the
button.
2. Click once into the correct row before double clicking on the relevant
vacancy to open it.
3. The Applicant Acceptance screen will be displayed and show a list of
applicants who have submitted an application.

4. The system will have given each applicant a unique applicant
number which will be displayed in the first column
If an applicant has requested to unsubmit an application (possibly
to make a change or addition), click the
button.
After the closing date:
5. Select the applications to be submitted by clicking on the tick box to
the right of the relevant applications (or click the

button).

6. Click the

button; this will import the applicants into Core.

7. Click the

button.
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8. A confirmation message will appear, click OK. The selected
applications will no longer be shown in the applicant acceptance
screen. Their status will show as Applied against the vacancy in the
Core back office.
After the vacancy closing date for priority candidates, you are
required to review each application received to ensure that the
letter of redeployment has been attached.

For any Priority Candidate applications received after the first
closing date, the status of Applied Late can be chosen instead.
This status may also be chosen if a vacancy has been reopened to allow a late application to be submitted.

9. Click the

button to exit the form.

1.2 Screen Applicants
Personnel > Recruitment > Maintenance > Applicant Status
1. The Search Criteria form will open. Enter your selection criteria
(normally the Vacancy Id and Applicant Status e.g. Applied) and click
the
button.
2. The applicants that match the search criteria will be displayed.
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After the vacancy closing date for priority candidates, you are
required to review each application to check that the letter of
redeployment has been attached. Where the redeployment letter
has been attached you should add ‘Priority Candidate’ into the
Comments field against the relevant applicant(s), and generate
and merge their applications and forward to the selection panel
for consideration ahead of the final closing date.
a. To view an applicant’s application, click once in the relevant row
and click the
button. The application will
display in a new window.
b. To view the applications of all applicants, click on the
button. The applications will display in a
new window.
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It is very important to review applicants and their applications to
ensure all are valid applicants e.g. check previous employees
have the right to return.
In the above example, update the Vacancy Events screen to
show that Right to Return has been checked. Refer to REC00:
Recruitment Basics for further details.

3. Where invalid applications are found, change the applicant status by
clicking the Status drop-down and selecting Invalid. Enter the
reason into the Comments field.
4. Click the

button.
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1.3 Generate Applications
The application submitted by each applicant is made up of a
number of parts. There are the web forms completed by the
applicant online, such as Referee Details and the Questionnaire
and then there are attachments, such as Supporting Statements
and CVs. Whilst the online parts of the application form one
document, each applicant can submit up to 5 additional
attachments, with each of these being held as a separate
document.
The Generate Applications process combines these separate
documents into a single PDF file per applicant. We complete this
process in two ways.
Firstly, an overnight job takes all applications that have been
submitted and automatically generates the PDF, without any action
being required by the recruitment administrator.
Secondly, following the closing date, the recruitment administrator
submits the applicants to the back office and is then able to
manually initiate this process in order to create the remaining PDF’s
for any applications received after the overnight process.
The process described in this document is the manual process as
completed by the recruitment administrator.
The steps below refer to the manual process for generating
applications and assume that the overnight job has worked as
expected.
Personnel > Recruitment > Maintenance > Applicant Status
1. The Search Criteria form will open. Enter your selection criteria
(normally the Vacancy Id and Applicant Status e.g. Applied) and click
the
button.
2. The applicants that match the search criteria will be displayed.
3. Click the
screen will appear.

button. The Generate Applications
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4. Select all applicants for whom you wish to generate a PDF file by
clicking the tick box to their right (or click the
button).
5. Click the

button.

6. A pop-up message will appear;

7. Click on the
button. The pop-up window and the Generate
Applications screen will close. As per the pop-up message, you will
now receive an email to the email account linked to your personnel
record once the job has been completed.
In the event that there is an error when generating the PDF, you
will receive an email containing a reference number. You should
forward this error message to hr.systems@admin.ox.ac.uk who
will resolve the issue with the application.
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8. Once you have received the email to confirm that your applications
have been generated, return to the Applicant Status screen and click
on the
button. The Generate Applications
screen will appear and you will see a link to the right of each
applicant. This link shows the date and time the PDF was created.
You can click on this link to open and view the PDF file.
9. To merge the individual PDF files into a single PDF pack for
distribution to the interview panel, proceed as follows:
a. Select the relevant applicants by clicking the tick box to the right of
each applicant (or click the
button).
b. Click the

button.

c. You will see a pop-up message explaining that your request has
been submitted and you will be sent an email when the job has
been completed.
d. Once you have received the email, return to the Generate
Applications screen and open the merged application pack by
clicking on the date/time stamp link in the bottom right corner of the
Generate Applications screen.
e. Select Save As from the File menu to save the PDF pack to a
secure location, or refer to the support website for suggested
approaches to managing shortlisting packs.

OUCS offer a facility called OxFile which supports the simple and
secure exchange of large files with people inside and outside the
University. Refer to
for further
details.

Where there are applications for priority applicants, and the letter
of redeployment has been attached, you should proceed to
generate and merge these applications and forward to the
selection panel for consideration as normal.
Follow steps 1.3 and 1.5 onwards contained within this quick
reference guide.
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To add an additional late application to the merged file, select
Delete Merged Application and click OK to the warning
message. Now create a new merged file following the
instructions in section 1.3, but selecting only the late applicant in
step 4, in order to generate their application.
Note: You will also create a new merged PDF when closing
vacancies requiring a Work Permit, in order to keep a final record
of all shortlisted applications. See section 6. Close the Vacancy
for further detail.

1.4 Manage Attachments
To view, add or ignore documents attached to the application by an
online applicant:
Personnel > Recruitment > Maintenance > Applicant Status
10.The Search Criteria form will open. Enter your selection criteria
(normally the Vacancy Id and Applicant Status e.g. Applied) and click
the
button.
11.Click once to highlight the row for the relevant applicant.
12.Click the

button.

13.Select Vacancy Detail in the Select Detail area.
14.Click once to highlight the row for the relevant vacancy.
15.Right click over the highlighted row.
16.Select View Documents from the shortcut menu. You will be taken
to the Document Details tab.
To Open a Document
a. Click on the file name. The document will open in a new window.
To Exclude a Document from the Selection Panel PDF File
a. Click to place a tick in the Ignore column against the relevant
attachment.
b. Click the

button.

To Attach an Additional Document
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a. If the additional document has been emailed to you by the
applicant, save it to a secure network location.
b. Click the
c. Click the
d. Click the

button. A new window will open.
button.
button.

e. Browse to select the relevant document.
f. Click the

button.

g. Once the upload has been successful click the
button to return to Core.
h. Click Yes to confirm the upload was successful.
i. Click the

button.

If you had already generated the PDF’s for the shortlisting
panel you will need to re-generate them at this point to
exclude the incorrect attachment and/or include the new one.
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1.5 Generate Shortlist Form
Use this option to generate the shortlist form for the Interview panel to
complete.
Personnel > Recruitment > Maintenance > Applicant Status
1. The Vacancy screen will open. In the Vacancy Id field, select your
vacancy from the list of values.
2. Select the relevant Applicant Status from the drop down e.g.
Applied.
3. Click the
displayed.

button. A list of relevant applicants will be

4. Select Tools > Letters from the menu. The Generate Letters
Module dialogue box will appear:
a. Ensure the Letter Group shows Recruitment.
b. Select the Letter Type Shortlist Form A - Standard or
Shortlist Form B – Extended.
c. Select the Selection option to send to All Query Records.
a. Click the

button.

5. Microsoft Word will open the template and merge applicant data to a
new document.
6. In the new document enter the relevant criteria in the column
headings.
7. Save, print and distribute the form as required.
8. Close Word and return to Core (note that after closing the document,
you will also need to close the letter template).
9. Click No to the confirmation message. This will stop the generation
of a record in the letter history.
If you have any priority candidates it is important to indicate these
against their entry on the form.
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At this stage you should:
1 Change the status of the vacancy to Shortlisting.
2. Update the vacancy events checklist e.g. Right to Return check.
Once shortlisting has been completed and the panel has reported
back with their decisions you should:
3. Change the status of the relevant applicants to Shortlisted or
Rejected after Shortlisting.
See QRG REC00 Recruitment Basics for further details on updating
statuses.

13

2. Manage Interviews
This section of the guide relates to process REC 7 Manage Interviews,
(and should be read in conjunction with), the recruitment process
outlined on the Personnel Services website at
http://www.admin.ox.ac.uk/personnel/recruit/recruitproc.

2.1 Schedule Interviews
Personnel > Recruitment > Maintenance > Vacancy Detail
1. The Search Criteria form will open. Enter your search criteria and
click the

button.

2. Double click the relevant vacancy to open it.
3. From the Select Detail area, select Applicant Status.
4. The Applicant Status Maintenance screen will be displayed. A list of
applicants will be displayed.
Ensure all applicants have the correct status, e.g. Shortlisted or
Rejected after Shortlisting (see REC00 Recruitment Basics quick
reference guide for further details).
5. To show only those applicants who you wish to invite to interview,
select the relevant status (e.g. Shortlisted) from the Applicant
Status drop-down in the search area at the top of the screen. Click
the
button.
6. Select the Schedules tab.
7. Click the
will be displayed.

button. The Add/Edit Schedule screen
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a. Select the Schedule Type e.g. Interview.
b. Select the Round and Schedule Number (if required).
c. Enter a Title e.g. Interviews for [job title].
d. From the Assign Type, select whether you want to schedule the
interviews on an individual basis or as a group.
e. Select the Status of the applicants that you wish to invite (e.g.
Shortlisted).
f. Enter the name of the Venue. This can include the full address so
that it can be merged into the interview invite letter.
g. Enter the Start Date for the interviews (remember to use the
format dd-mmm-yyyy).
h. Enter the Start Time and End Time for the interviews (e.g.
between 9:00 and 17:00).
i. Enter the Duration and Lead Time (time after each interview) for
each interview in minutes.
j. Breaks - enter the time and duration (in minutes) for each break
required by the panel.
8. Click the

button.
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9. Click the
button. The Assign Applicant / Interviewer
screen will be displayed.

a. Select the applicants you wish to invite for interview by selecting
the tick box to the right of their row (or click the
button).
b. Click the
button. A time will be entered into the
schedule time column for each interviewee selected.
c. Click the
appear, click OK.

button. A confirmation message will

10. Select the Interviewers tab.
11.Select the interviewers you wish to use by selecting the tick box to
the right of their row, (or click the
button).
In order to do this you must first have recorded who the
interviewers are. See the section entitled ‘Add / Maintain
Interview Panel’ in QRG REC01 Creating a Vacancy for further
details.

12. Click the
button.
13. Select the Applicant Schedules tab to see the scheduled date and
time for each applicant.
14. Select the Interview Schedules tab to see the scheduled date and
time for each interviewer.
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2.2 Generate Interview Invites
For an example of how to send correspondence as email please see the
‘Send Rejection Emails’ section within this guide.
Personnel > Recruitment > Maintenance > Applicant Status
1. The Vacancy screen will open. In the Vacancy Id field, select your
vacancy from the list of values.
2. Select the relevant applicant status e.g. Shortlisted.
3. Click the
displayed.

button. A list of relevant applicants will be

4. Select Tools > Letters from the menu.
5. Ensure the Letter Group shows Recruitment and select the relevant
letter type e.g. Invite for first interview.
6. Select the relevant option, either, All Query Records (to send to all
the applicants returned from your search) or Current Record (to
send to just the applicant currently selected).
7. Ensure the Send Email field is unchecked.
8. Click the

button. The letter will be generated.

9. In Word, respond to any Fill In prompts as required.
10.If necessary, amend the text further.
11. Save, print and post the letter as required.
12. Close Word and return to Core (note that after closing the letter
document, you will also need to close the letter template).
13. Click Yes to the confirmation message. This will generate a record in
the letter history screen.
For help on how to customise your letter templates please contact
the HRIS Support Centre.

17

Once all the interview invitations have been sent you should change
the status of the vacancy to Interview and the applicant status of
invited applicants to Invited to Interview 1 (see QRG REC00
Recruitment Basics for further details).
N.B. If you are planning a second round of interviews, once the
invitations have been sent for round 2, change the applicant status
of these applicants to Invited to Interview 2.

2.3 Generate Rejection Emails
This example uses the Core email functionality to generate
correspondence. For an example of how to send correspondence as a
Word document please see previous section above.
Personnel > Recruitment > Maintenance > Applicant Status
1. The Vacancy screen will open. In the Vacancy Id field, select your
vacancy from the list of values.
2. Select the relevant applicant status e.g. Rejected at Shortlisting or
Rejected at Interview 1.
3. Click the
displayed.

button. A list of relevant applicants will be

4. Select Tools > Letters from the menu.
5. Ensure the Letter Group shows Recruitment and select the relevant
letter type e.g. REJECTION AFTER SHORTLISTING or REJECT –
PRIORITY CANDIDATE APPT.

6. Select the relevant option, either, All Query Records (to send to all
the applicants returned from your search) or Current Record (to
send to just the applicant currently selected).
7. Click to select the Send Email field.
8. Click the
displayed.

button. The Send Email screen will be

9. Amend the email address shown in the From field to the email
address you wish people to reply to.
10. Click the
button to apply the new email address to all
emails in this batch.
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11. Whilst this should not be required for rejection emails, you can
amend the content of the email if necessary.
If you have selected multiple recipients for the email, and wish to
amend the email text, edit each in turn, navigating through the list
of recipients by using the
button.

2.4 Manage Attachments to Emails
If you wish to add an attachment to the email/s, follow section 2.3 above
then:
1. Click the
2. Click the

button.
button.

3. Browse to the document you wish to attach and click it once to
select it.
4. Click the

button.

5. To add further attachments, click into the next row down and repeat
steps 13 – 15 above.
6. Click the

button.

7. A confirmation message will display, click the
8. Click the

button.

button.

9. To add the same attachment to all emails, click the
button.
10. Click the
appear, click OK.

button. A confirmation message will

Note: If you use the email type ‘GENERIC EMAIL TEMPLATE’ you
must add an attachment for all recipients of that email.
The system can be used to administer different rounds of
recruitment selection by repeating the steps outlined in sections 1.3
to 2.4 and selecting appropriately.
You should be careful to ensure the correct Vacancy and Applicant
statuses have been applied at each stage. Please see QRG
REC00: Recruitment Basics for further details of the uses of this
information.
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2.5 Define Applicant Events
Having completed the interview exercise the selection panel will
hopefully have selected a preferred candidate. Depending on the
candidate and the post, specific checks will be required.
Personnel > Recruitment > Maintenance > Vacancy Detail
1. If necessary, search for and open the relevant vacancy.
2. Select Events from the Select Details area. The events tabs will be
displayed.
3. Select the Applicant Events tab.
4. For each check that is required for the preferred candidate place tick
in the checkbox to the right of the item.
5. Click the
appear, click OK.

button. A confirmation message will

2.6 View Referees
It will be possible to view the referee details once an applicant has made
an application for a vacancy.
Personnel > Recruitment > Maintenance > Applicant Details
1. The Search Criteria form will open. Enter your selection criteria
(normally the Applicant No., click the
button and select the
applicant from the list provided) and click the
button.
2. Click once to highlight the row for the relevant applicant.
3. Double click on the highlighted row to open the Applicant
Maintenance screen.
4. Select Vacancy Detail in the Select Detail area.
5. Click once to highlight the row for the relevant vacancy.
6. Right click over the highlighted row.
7. Select View References from the shortcut menu. You will be taken
to the Reference Details tab.
8. To view the full details of a referee, click the
9. To close the referee details, click the
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button.
button.

10.To exit the referee details screen, click the

button.

Where applicant details have been added via the manual route,
the referee details can be edited and added to.
If the applicant has applied online, the referee details can only
be viewed.

2.7 Edit Referee Details – manual applicants only
Referee details may have changed since the time of application. Use
this section to amend the referee details for any applications which have
been entered via the manual application route.
Personnel > Recruitment > Maintenance > Applicant Details
1. The Search Criteria form will open. Enter your selection criteria
(normally the Applicant No., click on the
button and select the
applicant from the list provided) and click the
button.
2. Click once to highlight the row for the relevant applicant.
3. Double click on the highlighted row to open the Applicant
Maintenance screen.
4. Select Vacancy Detail in the Select Detail area.
5. Click once to highlight the row for the relevant vacancy.
6. Right click over the highlighted row.
7. Select View References from the shortcut menu. You will be taken
to the Reference Details tab.
8. To access the full details of a referee, click the

button.

9. Make the required changes.
10.Click the

button.

11.To exit the referee details screen, click the
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button.

2.8 Add Referee Details
The applicant may be required to supply further referee details. Use this
section to add details of further referees.
Personnel > Recruitment > Maintenance > Applicant Details
1. The Search Criteria form will open. Enter your selection criteria
(normally the Applicant No., click on the
button and select the
applicant from the list provided) and click the
button.
2. Click once to highlight the row for the relevant applicant.
3. Double click on the highlighted row to open the Applicant
Maintenance screen.
4. Select Vacancy Detail in the Select Detail area.
5. Click once to highlight the row for the relevant vacancy.
6. Right click over the highlighted row.
7. Select View References from the shortcut menu. You will be taken
to the Reference Details tab.
8. To add a new referee, click the

button.

9. Complete the fields as required.
10.Click the

button.

11.To exit the referee details screen, click the
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button.

3. Manage Repeat Recruitment
This section of the guide relates to process REC 7a Manage Interviews
and should be read in conjunction with the recruitment process
outlined on the Personnel Services website at:
http://www.admin.ox.ac.uk/personnel/recruit/recruitproc.
On occasions, having completed the shortlisting and interview process,
it may not have been possible to choose a preferred candidate.

3.1 Recruitment Re-run Required - Advertising
Not Being Repeated
Personnel > Recruitment > Maintenance > Vacancy Details
Where a preferred candidate has not been found and it is not planned
for the advertising to be repeated then change the vacancy status to ‘No
Appointment Made’ and close the vacancy.
Ensure all applicants are correctly updated with their final status before
you do so.
Refer to 6 Close the Vacancy at the end of this quick reference guide.

3.2 Recruitment Re-run Required - Advertising
To Be Repeated
Where it is planned for the advertising to be repeated, as part of the
recruitment re-run, it will need to be decided whether the vacancy will
now be advertised externally. Approval is required from the Joint Group
prior to the vacancy being advertised externally.
In order to seek approval, a case needs to be submitted to the Joint
Group.
Use the Recruitment Protocol Form available on
www.admin.ox.ac.uk/personnel/recruit/recruitproc/planapprove/protocol/
Notification will be sent from the Joint Group to advise whether the case
for external advertising has been approved or rejected.
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3.2 a Request for External Advertising Rejected
Personnel > Recruitment > Maintenance > Vacancy Details
After being notified that the Joint Group has rejected your request for
external advertising, it will need to be decided whether to repeat the
internal-only advertising.
Where it is decided not to repeat the internal-only advertising, then the
vacancy should be closed with a status of ‘No Appointment Made’. All
applicant statuses must be updated to reflect the final status before
closing the vacancy.
Refer to 6 Close the Vacancy at the end of this quick reference guide.
If it has been decided that internal-only advertising will be repeated, then
start the process again by creating a new vacancy.
Please refer to REC01: Creating a Vacancy in CoreHR for further
details.
The original vacancy needs to be closed; refer to 6 Close the Vacancy
at the end of this quick reference guide.
Remove the appointment from the old vacancy and add to the new one.
To set up the vacancy and recruitment details, refer to REC01:
Creating a Vacancy in CoreHR quick reference guide.
To update the Vacancy Events; refer to REC00: Recruitment Basics in
CoreHR quick reference guide.

3.2 b Request for External Advertising Approved
Personnel > Recruitment > Maintenance > Vacancy Details
Where external advertising has been approved by the Joint Group and
confirmation has been received by the recruitment administrator, create
a new vacancy, (refer to REC01: Creating a New Vacancy in CoreHR
quick reference guide).
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Update the old vacancy with a status of ‘No Appointment Made’ and
ensure all applicant statuses have been updated to reflect the final
status before closing the old vacancy.
Refer to 6. Close the Vacancy at the end of this quick reference guide.
Remove the appointment from the old vacancy and add to the new one.

4. Appoint New Employee: Replan Appointment
This section of the guide relates to process REC 7b Appoint New
Employee: Replan Appointment and should be read in conjunction with
the recruitment process outlined on the Personnel Services website at
http://www.admin.ox.ac.uk/personnel/recruit/recruitproc.
Where a preferred candidate has been appointed or a new starter has
not started, i.e. not commenced, or has left shortly after commencement,
this process enables you to review whether there is an alternative
candidate who could be approached, or the vacancy needs to be readvertised.
Where it is decided to refill the appointment, it should be checked
whether the planned appointment is within 6 months of the original
request. Where the planned appointment is within 6 months, then no
protocol approval is required. The departmental approver or divisional
approver, (depending on protocol required), can send an off-system
request via email to the Reward Team to request a new a planned
appointment.
Once received, the Reward Team will review the request for a new
planned appointment and will notify you when the planned appointment
has been authorised.
Contact the Reward Team: Reward@admin.ox.ac.uk
If required, seek approval for external advertising:
www.admin.ox.ac.uk/personnel/recruit/recruitproc/planapprove/protocol/.
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4.1 Possible Alternative Candidate
Interviewed?
4.1a Yes
1) Where a possible alternative candidate has been interviewed, contact
them in the first instance to see if they are still interested in the role.
2) Where the alternative candidate is still interested, the new planned
appointment will need to be linked to the original vacancy, refer to
REC01: Creating a Vacancy within CoreHR quick reference guide.
Update the Applicant Status to Preferred Candidate and follow through
the process contained within this guide, ‘5.1 Record Offer’.
Personnel > Recruitment > Maintenance > Vacancy Details
4.2 a No
1) Where a possible alternative candidate has been interviewed, but is
not now interested in the role, or an alternative had not been
interviewed, set up a new vacancy and add in the recruitment details as
required. Refer to REC01: Creating a Vacancy in CoreHR quick
reference guide.
2) Follow the steps contained in REC01: Creating a Vacancy in CoreHR
quick reference guide, to link the new planned appointment to the new
vacancy.
3) Update Vacancy Events to show that the vacancy is being readvertised and follow the steps within REC00: Recruitment Basics and
REC01: Creating a Vacancy in CoreHR quick reference guides and
continue with the standard recruitment process.

5. Manage Offers & Manage Checks
26

This section of the guide relates to process REC 8 Manage Offers and
9 Manage Checks, (and should be read in conjunction with), the
recruitment process outlined on the Personnel Services website at
http://www.admin.ox.ac.uk/personnel/recruit/recruitproc.
Having made a verbal offer to your preferred candidate the checks
linked to the applicant will need to be initiated off-system and then
logged.
At this stage you should:
1 Change the status of the vacancy to OFFER MADE.
2. Update the applicant events checklist when checks are
initiated.
3. Change the status of the applicant to Offer Made (if prepersonnel ‘live’), or Offer Made – Personnel (if post-personnel
‘live’). See 5.1 below for subsequent steps.
Note: The updating of these statuses at each stage is
imperative for equal opportunities monitoring and reporting.
See QRG REC00: Recruitment Basics for further details on
updating statuses.

5.1 Record Offer (post personnel go live)
Personnel > Recruitment > Maintenance > Applicant Status
If your preferred candidate applied via e-recruitment, having made a
verbal offer to them the details should be captured in the Recruitment
module. (Section A1)
When the candidate accepts the offer, the details should be updated
against the relevant vacancy (Section A2) before the vacancy is closed.
Note: ‘Recruitment Administrator’ access is required for this action.
Both sections A1 and A2 must be completed.
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Recruitment > Maintenance > Applicant Status
A1. Record verbal offer
1. Enter the vacancy number into the Vacancy ID field and click
[A].
2. Update the status of the preferred candidate to Offer Made –
Personnel [B].

A
B
B
B

3. A message will be displayed ‘Do you wish to record offer details?’
click the
button.
In the Appointment Offer screen:
A
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4. Select the Post Number [A] using the LoV icon then press the [Tab]
key.
5. Select the post number sequence [A] using the LoV icon then press
the [Tab] key.
Note: If the post number or post number sequence you are expecting is
not in the LoV list then contact HRIS Support.
6. Enter/change any details relevant to the offer details e.g.
Note: If preferred, this information can be left for now and completed at
appointment stage.
Field Name

Description

Effective date

Expected start date.

Job Text

This is the actual job title that will appear in the
template documents, such as the conditional
offer/contract letter.

Employee status

e.g. Permanent, Fixed term.

Sub Status

e.g. Full time, Part time.

Hours

Expected working hours per week, as agreed with
the individual.

FTE Hours

Standard FTE hours for this role (depends on
grade).

Comments

Record anything of interest about the offer made.

7. Click the

button:
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8. If required change/check any details relevant to the pay details.
Field Name

Description

Point

Grade point

Multiplier

Ensure this matches the FTE

9. Click the
button, then click the
Applicant status window is re-displayed.

button. The

A2. Record accepted offer
When the verbal offer has been accepted, the details must be captured
in the recruitment module in order that they can be pulled through to
personnel.
Follow steps 1-9 above but remember to update the status of the
preferred candidate to Offer Accepted – Personnel.
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5.2 Complete Applicant Events
Personnel > Recruitment > Maintenance > Applicant Detail
1. Search for and open the relevant applicant record.
2. Select Events from the Select Details area. The event tab will be
displayed.
3. As each required event is initiated, click in the Checklist field to add
a tick. The completion of each required event will be recorded within
CoreHR personnel. (See QRG PA0: Pre Arrival for further details).
4. Click the

button.

Ensure you also update the Vacancy Events screen to mark all
the relevant Equal Opportunities monitoring events.

6. Close the Vacancy
Personnel > Recruitment > Maintenance > Vacancy Detail
These steps must be completed once the vacancy has been filled, or if it
needs to be closed for any other reason.

6.1 Ensure pre-requisites have been met:
The Applicant and Vacancy Events MUST be completed with all
information relevant to the vacancy. This forms part of the review
of recruitment procedures and practices and ensures the ‘Code of
Practice on Staff Recruitment and Selection’ is operating
effectively.
The Applicant and Vacancy Statuses MUST be updated before a
vacancy to reflect the latest/final status for each. Where the
vacancy is being closed due to a direct appointment, use the
vacancy status ‘Appointment Made’. Further information can be
found in the Statuses and Events guidance which can be found
here http://www.admin.ox.ac.uk/personnel/recruit/recruitproc/vacancysetup/
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6.2 For vacancies requiring Work Permit:
For vacancies requiring a work permit, UKBA (the UK Border Agency)
requires you to keep a copy of all applications, in their original format,
relating to all applicants who were shortlisted for that vacancy.
The following steps have been confirmed to meet this requirement:
Personnel > Recruitment > Maintenance > Applicant Status
1. Repeat steps 1, 2 and 3 from section 1.3 Manage Applications in this
guide in order to open the ‘Generate Applications’ window for the
vacancy.
2. Click
. This will remove the date and time link in the
bottom right hand corner of the Generate Applications window and
will therefore remove the full PDF application pack initially created for
the Selection Panel.
3. Still within the same window, put a tick in the checkbox next to each
candidate who had been shortlisted for interview.
4. Click
. The system will merge the selected applicants
into a combined PDF file of just the shortlisted applicants. Once
complete, a link will appear to the right of the button showing the date
and time the PDF was created. The file should open automatically.
5. If necessary, click the date and time link to open the PDF. Select
Save As from the File menu to save this file to a secure location for
reference in relation to UKBA queries.

6.3 Enter Closing Date and Final Status:
Personnel > Recruitment > Maintenance > Vacancy Detail
1. The Search Criteria form will open. Enter your selection criteria and
click the
button. The Vacancy Detail screen will be
displayed.
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a. Select the appropriate vacancy status e.g. Appointment Made or
No Appointment Made.
b. Enter a date into the Date Closed field.
c. Select the Closed radial in the Vacancy Status/Date section of the
screen. Do not use the ‘Filled’ or ‘Hold’ radial.
2. Click the

button.
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